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  Graphical Analysis 1 

A Hot Hand 
You will measure the temperature of the palm of your hand and the palm temperatures of your 
teammates in this experiment. In the process, you will learn how to use the data-collection 
equipment you will be using throughout the school year. You will also get to know your 
teammates better.  

OBJECTIVES 
• Use a Temperature Probe to measure temperature.   
• Calculate temperature averages.   
• Compare results.   

MATERIALS 
Chromebook, computer, or mobile device 
Graphical Analysis 4 app 
Go Direct Temperature 
beaker   
water   
paper towel   

PROCEDURE 
1. Launch Graphical Analysis. Connect the Temperature 

Probe to your Chromebook, computer, or mobile 
device. 

2. Click or tap Mode to open Data Collection Settings. Set End Collection to 60 s. Click or tap 
Done. 

3. Measure the temperature of the palm of your hand. 

a. Click or tap Collect to start data collection. 
b. Pick up the Temperature Probe and hold its tip in the palm of your hand as shown in 

Figure 1. Data collection will end when 60 seconds have gone by. 
4. Record your highest temperature.  

a. When data collection is complete, a graph of temperature vs. time will be displayed. To 
examine the data pairs on the displayed graph, click or tap any data point. As you tap 

 

Figure 1    
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each data point, the time and temperature values of the point are displayed. Note: You 
can also adjust the Examine line by dragging the line. 

b. Record your highest temperature. 
5. Prepare the Temperature Probe for the next run. 

a. Cool the Temperature Probe by placing it into a beaker of room-temperature water until 
its temperature reaches the temperature of the water. The temperature of the probe is 
displayed in a meter on the screen.  

b. Use a paper towel to dry the probe. Be careful not to warm the probe as you dry it. 
6. Repeat Steps 3–5 for each person in your team. 

DATA 

Student name 
Maximum 

temperature 
(°C) 

    

    

    

    

Team average   

PROCESSING THE DATA 
1. Calculate the team average for the highest temperatures. Record the result in the data table. 

2. How did the maximum temperatures of your teammates compare? 

3. Who had the “hottest hand”? 

EXTENSION 
Determine the class average for maximum temperature. 
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Boyle’s Law: Pressure-Volume  
Relationship in Gases 

The primary objective of this experiment is to determine the relationship between the pressure 
and volume of a confined gas. The gas we use will be air, and it will be confined in a syringe 
connected to a Gas Pressure Sensor (see Figure 1). When the volume of the syringe is changed 
by moving the piston, a change occurs in the pressure exerted by the confined gas. This pressure 
change will be monitored using a Gas Pressure Sensor. It is assumed that temperature will be 
constant throughout the experiment. Pressure and volume data pairs will be collected during this 
experiment and then analyzed. From the data and graph, you should be able to determine what 
kind of mathematical relationship exists between the pressure and volume of the confined gas. 
Historically, this relationship was first established by Robert Boyle in 1662 and has since been 
known as Boyle’s law. 

OBJECTIVES 
• Use a Gas Pressure Sensor and a gas syringe to measure the pressure of an air sample at 

several different volumes. 
• Determine the relationship between pressure and volume of the gas. 
• Describe the relationship between gas pressure and volume in a mathematical equation. 
• Use the results to predict the pressure at other volumes. 

 

 

Figure 1    

MATERIALS 
Chromebook, computer, or mobile device 
Graphical Analysis 4 app 
Go Direct Gas Pressure 
20 mL gas syringe 
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PROCEDURE 
1. Prepare the data-collection equipment and an air sample for data collection. 

a. Launch Graphical Analysis. Connect the Gas Pressure Sensor to your Chromebook, 
computer, or mobile device. 

b. With the 20 mL syringe disconnected from the Gas Pressure Sensor, move the piston of 
the syringe until the front edge of the inside black ring (indicated by the arrow in 
Figure 1) is positioned at the 10.0 mL mark. 

c. Attach the 20 mL syringe to the valve of the Gas Pressure Sensor.  
2. Set up the data-collection mode. 

a. Click or tap Mode to open Data Collection Settings. Change Mode to Event Based. 
b. Enter Volume as the Event Name and mL as the Units. Click or tap Done. 

3. To obtain the best data possible, you will need to correct the volume readings from the 
syringe. Look at the syringe; its scale reports its own internal volume. However, that volume 
is not the total volume of trapped air in your system since there is a little bit of space inside 
the pressure sensor. 

To account for the extra volume in the system, you will need to add 0.8 mL to your syringe 
readings. For example, with a 5.0 mL syringe volume, the total volume would be 5.8 mL. It 
is this total volume that you will need for the analysis. 

4. You are now ready to collect pressure and volume data. It is easiest if one person takes care 
of the gas syringe and another enters volumes. 

a. Click or tap Collect to start data collection. 
b. Move the piston so the front edge of the inside black ring (see Figure 2) is positioned at 

the 5.0 mL line on the syringe. Hold the piston firmly in this position until the pressure 
value displayed on the screen stabilizes. 

c. Click or tap Keep and enter 5.8, the gas volume (in mL). Remember, you are adding 
0.8 mL to the volume of the syringe for the total volume. Click or tap Keep Point to store 
this pressure-volume data pair.  

 

Figure 2    

d. Continue this procedure using syringe volumes of 10.0, 12.5, 15.0, 17.5, and 20.0 mL.  
e. Click or tap Stop to stop data collection. 

5. When data collection is complete, a graph of pressure vs. volume will be displayed. To 
examine the data pairs on the displayed graph, tap any data point. As you tap each data point, 
the pressure and volume values are displayed to the right of the graph. Record the pressure 
and volume data values in your data table. 
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6. Based on the graph of pressure vs. volume, decide what kind of mathematical relationship 
exists between these two variables, direct or inverse. To see if you made the right choice: 

a. Click or tap Graph Tools, , and choose Apply Curve Fit. 
b. Select Power as the curve fit and Dismiss the Curve Fit box. The curve fit statistics are 

displayed for the equation in the form 
y = axb 

where x is volume, y is pressure, a is a proportionality constant, and b is the exponent of 
x (volume) in this equation. Note: The relationship between pressure and volume can be 
determined from the value and sign of the exponent, b. 

c. If you have correctly determined the mathematical relationship, the regression line should 
very nearly fit the points on the graph (that is, pass through or near the plotted points). 

d. Rescale the axes on your graph by clicking or tapping Graph Tools, . Choose Edit 
Graph Options and set the x-axis to display 0 to 25 mL and the y-axis to display 0 to 
300 kPa. Dismiss the Graph Options box. 

e. (optional) Export, download, or print the graph with the curve fit displayed. 
7. With the best-fit curve still displayed, proceed directly to the Processing the Data section.  

DATA AND CALCULATIONS 
Volume 

(mL) 
Pressure 

(kPa) 
Constant, k 

(P / V or P • V) 

      

      

      

      

      

      

      

PROCESSING THE DATA 
1. With the best-fit curve still displayed, click or tap Graph Tools, , and turn on Interpolate. 

Dismiss the Graph Tools box and click the graph to interpolate. Move along the regression 
line until the volume value is 5.0 mL. Note the corresponding pressure value. Now move to 
the point where the volume value is doubled (10.0 mL). What does your data show happens 
to the pressure when the volume is doubled? Show the pressure values in your answer. 
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2. Using the same technique as in Question 1, what does your data show happens to the 
pressure if the volume is halved from 20.0 mL to 10.0 mL? Show the pressure values in your 
answer. 

3. Using the same technique as in Question 1, what does your data show happens to the 
pressure if the volume is tripled from 5.0 mL to 15.0 mL? Show the pressure values in your 
answer. 

4. From your answers to the first three questions and the shape of the curve in the plot of 
pressure vs. volume, do you think the relationship between the pressure and volume of a 
confined gas is direct or inverse? Explain your answer.  

5. Based on your data, what would you expect the pressure to be if the volume of the syringe 
was increased to 40.0 mL? Explain or show work to support your answer. 

6. Based on your data, what would you expect the pressure to be if the volume of the syringe 
was decreased to 2.5 mL? Explain or show work to support your answer. 

7. What experimental factors are assumed to be constant in this experiment?  

8. One way to determine if a relationship is inverse or direct is to find a proportionality 
constant, k, from the data. If this relationship is direct, k = P/V. If it is inverse, k = P•V. Based 
on your answer to Question 4, choose one of these formulas and calculate k for the seven 
ordered pairs in your data table (divide or multiply the P and V values). Show the answers in 
the third column of the Data and Calculations table.  

9. How constant were the values for k you obtained in Question 8? Good data may show some 
minor variation, but the values for k should be relatively constant. 

10.  Using P, V, and k, write an equation representing Boyle’s law. Write a verbal statement that 
correctly expresses Boyle’s law.  

EXTENSION 
1. To confirm that an inverse relationship exists between pressure and volume, a graph of 

pressure vs. reciprocal of volume (1/volume) may also be plotted. To do this, it is necessary 
to create a new column of data, reciprocal of volume, based on your original volume data: 

a. Click or tap More Options, , in the Volume column header in the table. Choose Add 
Calculated Column. 

b. Enter 1/volume as the Name and 1/mL as the Units.  
c. Click or tap Insert Expression and choose A/X as the expression. 
d. Enter 1 as Parameter A and select Volume as the Column. 
e. Click or tap Apply.  
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2. Plot a best-fit regression line on your graph of pressure vs. 1/volume: 

a. Click or tap Graph Tools, , and choose Edit Graph Options.  
b. Enter 0 as the value for both the Left value for the x-axis and the Bottom value for the y-

axis. 
c. Dismiss the Graph Options box. Your graph should now include the origin (0,0). 
d. Click or tap Graph Tools, , and choose Apply Curve Fit. 
e. Select Linear as the curve fit and Dismiss the Curve Fit box. The linear-regression 

statistics are displayed in the form: 
y = mx + b 

where x is 1/volume, y is pressure, m is a proportionality constant, and b is the y-
intercept. 

f. If the relationship between P and V is an inverse relationship, the graph of pressure vs. 
1/volume should be direct; that is, the curve should be linear and pass through (or near) 
the origin. Examine your graph to see if this is true for your data. 
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  LabQuest App 11 

Cell Respiration 
(CO2 Gas Sensor) 

Cell respiration refers to the process of converting the chemical energy of organic molecules into 
a form immediately usable by organisms. Glucose may be oxidized completely if sufficient 
oxygen is available by the following equation: 

C6H12O6 + 6 O2(g) →�6 H2O + 6 CO2(g) + energy 

All organisms, including plants and animals, oxidize glucose for energy. Often, this energy is 
used to convert ADP and phosphate into ATP. It is known that peas undergo cell respiration 
during germination. Do peas undergo cell respiration before germination? The results of this 
experiment will verify that germinating peas do respire. Using your collected data, you will be 
able to answer the question concerning respiration and non-germinating peas. 

Using the CO2 Gas Sensor, you will monitor the carbon dioxide produced by peas during cell 
respiration. Both germinating and non-germinating peas will be tested. Additionally, cell 
respiration of germinating peas at two different temperatures will be tested.  

OBJECTIVES 
• Use a CO2 Gas Sensor to measure concentrations of carbon dioxide. 
• Study the effect of temperature on cell respiration. 
• Determine whether germinating and non-germinating peas respire. 
• Compare the rates of cell respiration in germinating and non-germinating peas. 

 

Figure 1    
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MATERIALS 
LabQuest 
LabQuest App 
CO2 Gas Sensor 
250 mL respiration chamber 
25 germinating peas 
25 non-germinating peas 
ice water 
thermometer 
100 mL beaker 
paper towels 
goggles 

PROCEDURE 
1. If your sensor has a switch, set it to the Low (0–10,000 ppm) setting. Connect the CO2 Gas 

Sensor to LabQuest and choose New from the File menu. 

2. On the Meter screen, tap Duration. Change the data-collection duration to 300 seconds. 

3. Measure the room temperature using a thermometer and record the temperature in Table 1. 

4. Obtain 25 germinating peas and blot them dry between two pieces of paper towel.  

5. Place the germinating peas into the respiration chamber. 

6. Place the shaft of the CO2 Gas Sensor in the opening of the respiration chamber. Gently push 
the sensor down into the chamber until it stops. The sensor is designed to seal the chamber 
without the need for unnecessary force. 

7. Wait one minute, then start data collection. Data will be collected for 5 minutes. 

8. When data collection has finished, remove the CO2 Gas Sensor and peas from the respiration 
chamber. Place the peas in a 100 mL beaker filled with ice water. 

9. Use a notebook or notepad to fan air across the openings in the probe shaft of the CO2 Gas 
Sensor for 1 minute.  

10. Fill the respiration chamber with water and then completely empty it to remove residual gas 
from the peas. Thoroughly dry the inside of the respiration chamber with a paper towel.  

11. Perform a linear regression to calculate the rate of respiration. 

a. Choose Curve Fit from the Analyze menu. 
b. Select Linear for the Fit Equation.  
c. Enter the slope, m, as the rate of respiration in Table 2. 
d. Select OK. 

12. Store the data from the first run by tapping the File Cabinet icon. 
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13. Obtain 25 non-germinating peas and place them in the respiration chamber. 

14. Repeat Steps 6–12 with non-germinating peas. In Step 8 place the non-germinating peas on a 
paper towel and not in the ice bath. 

Part II  germinating peas, cool temperatures 

15. Remove the peas from the cold water and blot them dry between paper towels. 

16. Use the thermometer to measure the temperature of the ice water. Record the temperature in 
Table 1. 

17. Repeat Steps 5–11 using the cold peas. In Step 8 place the cold germinating peas on a paper 
towel and not back in the ice bath. 

18. To graph all three runs of data on a single graph, tap Run 3 and select All Runs. Continue to 
the Analysis Questions. 

DATA 
Table 1 

Condition Temperature  
(°C) 

Room   

Ice water   

  

Table 2 

Peas Rate of respiration 
(ppm/s) 

Germinating, room temperature   

Non-germinating, room temperature   

Germinating, cool temperature   

QUESTIONS 
1. Do you have evidence that cell respiration occurred in peas? Explain. 

2. What is the effect of germination on the rate of cell respiration in peas? 

3. What is the effect of temperature on the rate of cell respiration in peas? 

4. Why do germinating peas undergo cell respiration? 
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EXTENSIONS 
1. Compare the respiration rate among various types of seeds. 

2. Compare the respiration rate among seeds that have germinating for different time periods, 
such as 1, 3, and 5 days. 

3. Compare the respiration rates of various small animal types, such as insects or earthworms. 
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  LabQuest App 16 

Acid Rain and Its Effect 
on Surface Water  

Acid rain can be very harmful to the environment. It can kill fish by lowering the pH of lakes and 
rivers. It can harm trees and plants by burning their leaves and depriving them of nutrients. It can 
also weather away stone buildings and monuments. But why is it more of a problem in some 
places than others? 

To answer this question, let’s first look at how rain becomes acidic. Carbon dioxide, CO2, is a 
gas found naturally in the air. When CO2 dissolves into rain droplets, it produces a weak acid 
called carbonic acid, H2CO3. This makes rain slightly acidic naturally. Rain of pH 5 to 6 is 
common and does not generally cause any problems. When fossil fuels are burned, however, 
gases such as sulfur dioxide, SO2, are released into the air. When sulfur dioxide dissolves into 
rain droplets, sulfuric acid, H2SO4, is formed. This rain can be as acidic as pH 4. Figure 1 shows 
the trend of rain pH in the United States in a typical year. Notice that the most acidic rain occurs 
over and downwind from heavily populated and industrialized areas.  

 

Figure 1  Typical rain pH in United States 

Acid rain is more harmful to some areas than others. This is because some water resists changes 
in pH better than others. Water that resists a change in pH is said to be buffered. Depending on 
the buffering capacity of the surface water, one area could be heavily damaged by acid rain that 
does not seem to harm another at all.  

In Part I of this experiment, you will study how rain naturally becomes acidic due to CO2 in the 
air. You will monitor the pH of water as you add CO2 by blowing through a straw. In Part II, you 
will study the effect of acid rain has on the pH of different water types. The pH will be recorded 
as sulfuric acid is added dropwise to several different types of water. 
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OBJECTIVES 
• Use a pH Sensor to measure pH. 
• Use a pH Sensor to study the effect of dissolved CO2 on the pH of distilled water. 
• Study the effect on pH of dissolving H2SO4 in various waters. 
• Learn why some bodies of water are more vulnerable to acid rain than others. 

MATERIALS 
LabQuest  
LabQuest App 
Vernier pH Sensor 
100 mL beaker 
waste beaker 
ring stand and utility clamp 
straw 
wash bottle with distilled water 
soft water 
hard water 
buffer solution 
dilute H2SO4  
dropper 

PROCEDURE 

Part I CO2 and Water 
1. Obtain and wear goggles! Caution: The sulfuric acid used in Part II of this experiment is a 

strong acid. Contact with sulfuric acid will damage your skin, eyes, and clothing! 

2. Connect the pH Sensor to LabQuest and choose New from the File menu. If you have an 
older sensor that does not auto-ID, manually set up the sensor. Important: For this 
experiment your teacher already has the pH Sensor in pH soaking solution in a beaker; be 
careful not to tip over the beaker when connecting the sensor to the interface. 

3. On the Meter screen, tap Rate. Change the data-collection rate to 1 sample/second and the 
data-collection length to 60 seconds. Select OK. 
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Figure 2    
4. Add 50 mL of distilled water to a clean 100 mL beaker.  

5. Lower the pH electrode into the beaker so that the water is covering the glass bulb. 

6. Give a straw to the group member who will be blowing into the water.  

7. Start data collection. After one data pair have been collected, begin blowing through the 
straw into the distilled water. You may take breaths as needed, but try to keep a fairly 
constant stream of air going into the water. Data collection will stop after 60 seconds. 

8. Determine the maximum and minimum pH values. 

a. Choose Statistics from the Analyze menu. 
b. Record the maximum and minimum pH in the Part I data table. 

9. Print the graph as directed by your teacher. 

Part II  Effects of Acid Rain on Surface Water 
Acid Rain in Distilled Water 

10. Set up LabQuest for data collection in the Event with Entry mode. 

a. On the Meter screen, tap Mode. Change the data-collection mode to Events with Entry. 
b. Enter the Name (Drops) and leave Units field blank. Select OK.  

11. Rinse the pH electrode thoroughly with distilled water. 

12. Wash and dry the 100 mL beaker. Get a new 50 mL portion of distilled water. Lower the pH 
Sensor into the distilled water. 

13. Start data collection.  
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14. When the pH reading displayed on the screen stabilizes, tap Keep. Enter 0 (the number of 
drops). Select OK to save this data pair. 

15. Add 1 drop of sulfuric acid to the water. Caution: Handle the sulfuric acid with care. It can 
cause painful burns if it comes into contact with skin, eyes, or clothing. 

16. Stir thoroughly. When the pH is stable, tap Keep. Enter the number of drops of acid added to 
the beaker and select OK. 

17. Repeat Steps 15–16, adding 1 drop at a time, until you have added 10 drops of acid.  

18. Stop data collection.  

19. To examine the data pairs on the displayed graph, tap any data point. As you tap each data 
point, the pH and drop number values are displayed to the right of the graph. 

20. Record the maximum and minimum pH values in the Part II data table. 

21. Store the data from the first run by tapping the File Cabinet icon. 

Acid Rain in Soft Water 

22. Repeat Steps 11–21 using 50 mL of soft water instead of distilled water.  

Acid Rain in Hard Water 

23. Repeat Steps 11–20 using 50 mL of hard water instead of distilled water. Important: Do not 
store this final run.  

24. It is often helpful to view all three runs on one graph for comparison. 

a. Tap Run 3 and select All Runs.  
b. Print the graph or sketch it in the space below, labeling each line with the type of water 

used. 

DATA  

Part I CO2 and Water 

Table 1 

Maximum pH Minimum pH ΔpH 
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Part II  Effects of Acid Rain on Surface Water 
Table II 

  Distilled Water Soft Water Hard Water 

Maximum pH       

Minimum pH       

ΔpH       

PROCESSING THE DATA 
1. Calculate the change in pH (ΔpH) for the water in Part I and record in the Part I data table. 

2. Calculate the change in pH (ΔpH) for each of the Part II trials and record in the Part II data 
table. 

3. Compare the ΔpH values. Which test gave the largest pH change? Which test gave the 
smallest pH change? 

4. Hard water is said to be “naturally buffered.” From the result of this experiment, explain 
what this means. 

5. Many aquatic life forms can only survive in water with a narrow range of pH values. In 
which type of water—hard or soft—would living things be more threatened by acid rain? 
Explain. 

 

Figure 3  Typical water hardness as mg/L calcium carbonate. 

6. Figure 3 shows the general trend in hard and soft water in the United States. There are 
numerous coal-burning electric power plants in Illinois that produce sulfur dioxide. As the 
prevailing winds carry the pollutants northeastward, they contribute to acid rain over the 
Northeast. Based on what you have learned in this lab, do you think that Ohio and New York 
will be affected the same by this acid rain? Why or why not? 
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7. A similar situation exists in Europe where air pollutants from highly industrialized Germany 
are more harmful to Scandinavian water life than to water life in Germany. Use the results of 
this experiment to predict the relative hardness and softness of Germany and Scandinavia’s 
water. 

EXTENSIONS 
1. Test ocean water in the same way you tested hard and soft water. How does it compare? 

2. Do library research to get more information on the effects of acid rain on streams and lakes. 
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